CÂU HỎI ÔN TẬP MS WORD VÀ MS EXCEL 2010
SỬ DỤNG ĐỂ ÔN TẬP THI NGHỀ MÔN TIN HỌC

I. Phần MS WORD
Câu 1: Ở mức cơ sở nhất, văn bản được tạo từ các:

A. Ký tự.
B. Từ.
C. Câu.
D. Đoạn văn bản.
Câu 2: Nhiều câu có liên quan với nhau hoàn chỉnh về ngữ nghĩa nào đó tạo thành một:

A. Đoạn văn bản.
B. Ký tự.
C. Từ.
D. Câu.
Câu 3: Phần văn bản định dạng để in ra trên một trang giấy gọi là:
A. Trang.
B. Trang màn hình.
C. Dòng.
D. Đoạn văn bản.
Câu 4: Phần văn bản hiển thị trên màn hình tại một thời điểm được gọi là:

A. Trang màn hình.
B. Trang.
C. Dòng.
D. Đoạn văn bản.
Câu 5: Trong MS Word, thế nào là một đoạn văn bản? 

A. Là đoạn văn được kết thúc bằng dấu chấm (.).
B. Là 1 đoạn văn được kết thúc bằng phím Enter.
C. Là một văn bản kết thúc bằng một trang giấy.
D. Là một văn bản kết thúc bằng dấu hai chấm (:).
Câu 6: Để lưu văn bản, ta bấm vào nút lệnh:
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Câu 7: Bộ mã chung cho mọi ngôn ngữ của các quốc gia trên thế giới tên là

A. Unicode.
B. VNI.
C. TCVN3.
D. Telex.
Câu 8: Điền vào chỗ trống: Để chọn văn bản, ta đặt con trỏ văn bản vào vị trí bắt đầu chọn, nhấn giữ phím ______ rồi đặt con trỏ văn bản vào vị trí kết thúc.
A. Shift.
B. Ctrl.
C. Alt.
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D. Insert.
Câu 9: Theo hình bên, bảng được tạo ra sẽ có:

A. 5 cột, 2 hàng
B. 2 cột, 5 hàng

C. 5 cột, mỗi cột rộng 2cm
D. 2 cột, mỗi cột rộng 5cm

Câu 10: Trong MS Word 2010, để tạo khoảng cách giữa 2 dòng là 1,5 dòng ta thực hiện lệnh nào?

A. Nhấn Ctrl+5
B. Nhấp chuột phải lên đoạn đang chọn, chọn 1,5 lines

C. Nhấp biểu tượng  [image: image5.png]


  trên thẻ Home
D. Tại thẻ Page Layout, nhấp nút  [image: image6.png]


  và chọn 1,5
Câu 11: Trong MS Word 2010, phím nào sau đây đưa con trỏ về đầu dòng hiện hành?

A. Home.
B. Ctrl + Home.
C. End.

D. Ctrl + Page Up.
Câu 12: Trong Word 2010, để chuyển con trỏ về đầu tài liệu nhấn:
A. Ctrl + Page Up.
B. Ctrl + End.
C. Home.
D. Ctrl + Home.
Câu 13: Khi thao tác trong MS Word 2010, thông báo “Do you want to save changes to...” xuất hiện khi nào?

A. Khi chọn một phông chữ (font) mà nó không tồn tại trong máy.
B. Không đặt tên file khi lưu văn bản.
C. Khi đóng văn bản nhưng văn bản chưa được lưu.
D. Khi lưu văn bản với tên file trùng với một file đã có trong thư mục lựa chọn.
Câu 14: Trong MS Word 2010, để gộp các ô đang chọn của một bảng thành một ô ta thực hiện:
A. Vào thẻ Home, nhấp nút Merge Cells.
B. Vào thẻ Home, nhấp nút Split Cells.
C. Vào thẻ Layout, nhấp nút Merge Cells.
D. Vào thẻ Layout, nhấp nút Split Cells.
Câu 15: Trong MS Word 2010, phím nào để xoá ký tự đứng trước con trỏ?

A. Page Down.
B. Delete.

C. Page Up.

D. Backspace.
Câu 16: Nhấp chuột trái liên tiếp 03 lần vào vị trí nào đó trong đoạn văn bản sẽ có tác dụng gì?

A. Chọn toàn bộ văn bản.
B. Chọn nguyên đoạn văn bản tại vị trí nhấp chuột.
C. Chọn một từ.
D. Chọn một dòng.
Câu 17: Trong Word 2010, sau khi bôi đen toàn bộ bảng, nếu nhấn phím Delete thì điều gì xảy ra?

A. Không có tác dụng gì.
B. Xóa toàn bộ nội dung và bảng biểu.
C. Xóa bảng, không xóa nội dung.
D. Xóa toàn bộ nội dung trong bảng, không xóa bảng.
Câu 18: Mỗi tập tin MS Word 2010 được lưu lại sẽ có phần mở rộng mặc định là _______
A. PDF

B. DOCX
C. XLS

D. DOC

Câu 19: Trong MS Word 2010, khi cần gõ các chỉ số dưới (như x2, an, H2O,…) thì sử dụng tổ hợp phím tắt ______ trong khi gõ.
A. Ctrl+=
B. Ctrl+Shift+=

C. Ctrl+Alt+Shift+=

D. Shift+=

Câu 20: Trong MS Word 2010, tổ hợp phím nào dùng để tăng, giảm cỡ chữ cho nội dung văn bản?

A. Ctrl+1 hay Ctrl+2

B. Ctrl+[ hay Ctrl+]
C. Ctrl+< hay Ctrl+>
D. Shift+[ hay Shift+]
Câu 21: Trong Word 2010, công dụng của tổ hợp phím Ctrl+C là gì?
A. Sao chép các nội dung đang lựa chọn vào bộ nhớ đệm.
B. Phục hồi lại các thao tác đã làm trước đó.
C. Dán tất cả các nội dung đã được sao chép trước đó vào vị trí con trỏ.
D. Thực hiện canh lề giữa đoạn văn bản đó.
Câu 22: Trong MS Word 2010, tổ hợp phím Ctrl+S được thay cho lệnh nào dưới đây?

A. Vào File, chọn Save and Send.
B. Vào File, chọn Save.
C. Vào File, chọn lệnh Open.
D. Vào File, chọn lệnh Save As.
Câu 23: Trong MS Word 2010, thao tác giữ phím Ctrl và nhấp chuột vào một vị trí nào đó trong đoạn văn bản sẽ có tác dụng gì?

A. Chọn đoạn văn bản.
B. Chọn toàn bộ văn bản.
C. Chọn một câu tại vị trí con trỏ.
D. Chọn một từ.
Câu 24: Trong Word 2010, để chọn từ con trỏ về đầu tài liệu nhấn:
A. Ctrl + Home
B. Ctrl + End
C. Ctrl + Page Up

D. Ctrl + Shift + Home
Câu 25: Trong MS Word 2010, tổ hợp phím ______ được sử dụng thay thế cho thao tác click vào nút [image: image7.png]


 trên thẻ Home.

A. Ctrl+B
B. Alt+C
C. Shift+B
D. Ctrl+Shift+B

Câu 26: Trong MS Word 2010, để chèn thêm một dòng bên dưới dòng đang chọn trong một bảngthì ta vào thẻ Layout rồi chọn nút lệnh gì?

A. Insert Above

B. Insert Below
C. Rows Below

D. Insert Right
Câu 27: Trong MS Word 2010, cách nhanh nhất để chọn đoạn văn bản từ con trỏ về cuối dòng là nhấn tổ hợp phím _________

A. Alt + F8
B. Ctrl + End

C. Shift +End
D. Alt+ A.

Câu 28: Cách nào sau đây được dùng để thay đổi Zoom cho văn bản hiện hành trong chương trình MS Word 2010?

A. Tại thẻ View, chọn nút Full Screen Reading.
B. Tại thẻ View, chọn nút Zoom trong nhóm Zoom.
C. Lăn nút cuộn của chuột.
D. Nhấn và giữ phím ALT trong khi lăn nút cuộn của chuột.
Câu 29: Trong Word 2010, để chuyển con trỏ về cuối văn bản nhấn:
A. Page Down

B. Ctrl + Page Down

C. End

D. Ctrl + End

Câu 30: Trong MS Word 2010, để chọn toàn bộ nội dung văn bản thì nhấn tổ hợp phím ______

A. Shift+Ctrl+A

B. Ctrl+A
C. Ctrl+Alt+A

D. Shift+A

Câu 31: Trong MS Word 2010, để chèn thêm một cột bên trái cột đang chọn của một bảng, ta vào thẻ Layout rồi chọn nút lệnh gì?

A. Left Columns.
B. Insert Below.
C. Insert Above.
D. Insert Left.
Câu 32: Trong MS Word 2010, để đặt lề giấy cho văn bản đang soạn thảo, ta chọn thẻ Page Layout, rồi chọn nút _______ rồi chọn một tùy chọn lề.

A. Orientation.
B. Size.
C. Margins.
D. Page Setup.
Câu 33: Trong MS Word 2010, để thay đổi hướng in cho tài liệu ta chọn thẻ Page Layout, rồi chọn nút _________ rồi chọn một tùy chọn hướng in.

A. Orientation.
B. Size.
C. Margins.
D. Page Setup.
Câu 34: Trong MS Word 2010, để chia cột cho đoạn văn bản đang chọn, ta thực hiện như thế nào?

A. Tại thẻ Page Layout, nhấp chọn Columns.
B. Tại thẻ Insert, nhấp chọn Columns.
C. Tại thẻ Page Layout, nhấp chọn Line Numbers.
D. Tại thẻ Home, nhấp chọn Columns.
Câu 35: Trong MS Word 2010, để thay đổi khoảng cách giữa hai đoạn văn bản ta thiết lập tại _________?

A. Ô Before và After trong thẻ Page Layout.
B. Ô Line Spacing trong thẻ Page Layout.
C. Ô Left và Right trong thẻ Page Layout.
D. Ô Above và Below trong thẻ Page Layout.
Câu 36: Trong MS Word 2010, tổ hợp phím ______ được dùng để lưu văn bản?

A. Ctrl+0
B. Ctrl+P
C. Ctrl+N

D. Ctrl+S

Câu 37: Trong MS Word 2010, trong khi soạn thảo văn bản, sau khi chọn một khối văn bản, ta nhấn phím số 1 thì:
A. Khối văn bản đó biến mất.
B. Khối văn bản đó biến mất và thay vào đó là số 1.
C. Số 1 sẽ chèn vào trước khối đang chọn.
D. số 1 sẽ chèn vào sau khối đang chọn.
Câu 38: Trong Word 2010, biểu tượng ____ và tổ hợp phím ____ có công dụng như nhau?
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 và Ctrl+R
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 và Ctrl+L
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 và Ctrl+U
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 và Ctrl+I

Câu 39: Trong MS Word 2010, khi cần gõ các chỉ số trên (như x2, an, cm3...) thì sử dụng phím tắt ______ trong khi gõ.

A. Ctrl+=

B. Ctrl+Shift+=

C. Shift+=

D. Ctrl+Alt+Shift+=

Câu 40: Phát biểu nào sau đây là SAI?

A. Căn lề mặc định trong văn bản mỗi khi tạo tập tin mới là căn trái.
B. Khi soạn thảo trong Word, nếu hết trang thì tự động nhảy sang trang mới.
C. Chỉ được phép mở một văn bản trong phiên làm việc.
D. Mặc định khi khởi động MS Word 2010 đã có một văn bản trống.
Câu 41: Phát biểu nào sau đây là đúng?

A. Tập tin được tạo ra bởi Word 2010 khi lưu sẽ có đuôi mặc định là XLSX

B. Trong MS Word 2010 ta không thể gõ tiếng Việt
C. MS Word 2010 là một phần mềm tính toán

D. Mặc định mỗi khi khởi động MS Word 2010 đã có một văn bản trống

Câu 42: Trong MS Word 2010, để chèn một ký hiệu đặc biệt vào văn bản ta thực hiện:
A. Tại thẻ Insert, nhấp nút Special…
B. Tại thẻ Home, nhấp nút Symbol…
C. Tại thẻ Insert, nhấp nút Symbol…
D. Tại thẻ Home, nhấp nút Special…
Câu 43: Trong MS Word 2010, để chèn hình ảnh từ bên ngoài vào văn bản ta thực hiện:
A. Tại thẻ Insert, nhấp nút ClipArt…
B. Tại thẻ Home, nhấp nút Clip Art…
C. Tại thẻ Insert, nhấp nút Picture…
D. Tại thẻ Home, nhấp nút Picture…
Câu 44: Trong MS Word 2010, để nối hai đoạn văn bản số 1 và đoạn văn bản số 2 thành một đoạn ta thực hiện

A. Đặt con trỏ dầu đoạn số 2, nhấn phím Backspace.
B. Đặt con trỏ đầu đoạn số 2, nhấn phím Delete.
C. Đặt con trỏ đầu đoạn số 1, nhấn phím backspace.
D. Đặt con trỏ đầu đoạn số 1, nhấn phím Delete.
Câu 45: Trong văn bản MS Word 2010 đang mở, nếu muốn sử dụng chức năng tìm kiếm và thay thế, ta thực hiện:
A. Chọn Insert, chọn Replace
.
B. Chọn Home, chọn Find.
C. Chọn Insert, chọn Find.
D. Chọn Home, chọn Replace

Câu 46: Trong MS Word 2010, để thực hiện ngắt trang cho văn bản ta sử dụng tổ hợp phím gì?

A. Ctrl+ESC

B. Ctrl+S
C. Ctrl+Space
D. Ctrl+Enter
Câu 47: Trong MS Word 2010, để chèn số trang vào vị trí con trỏ của tài liệu ta thực hiện:
A. Vào Insert, nhấp Page Number và chọn Bottom of Page.
B. Vào Insert, nhấp Page Number và chọn Top of Page.
C. Vào Insert, nhấp Page Number, chọn Current Position.
D. Vào Insert, nhấp Number Page, chọn Format Page Numbers.
Câu 48: Trong Word 2010, để đánh số trang ở lề trên, ta thực hiện:
A. Vào Page Layout, nhấp Page Number và chọn Bottom of Page.
B. Vào Page Layout, nhấp Page Number và chọn Top of Page.
C. Vào Insert, nhấp Page Number, chọn Top of Page.
D. Vào Insert, nhấp Number Page, chọn Bottom of Page.
Câu 49: Trong MS Word 2010, để thay đổi khổ giấy cho tài liệu, ta chọn thẻ Page Layout, rồi chọn nút _____ rồi chọn khổ giấy thích hợp.
A. Margins.
B. Size.
C. Orientation.
D. Page Setup.
Câu 50: Trong MS Word 2010, tổ hợp phím nào dùng để bật hộp thoại tìm kiếm?

A. Ctrl+H

B. Ctrl+G

C. Shift+F

D. Ctrl+F
Câu 51: Trong MS Word 2010, thao tác nào dưới đây được dùng để chọn một từ trong đoạn văn bản?
A. Giữ phím Ctrl và nhấn chuột trái lên câu cần chọn

B. Giữ phím Shift và nhấn chuột trái lên câu cần chọn

C. Nhấn chuột trái 3 lần vào Iề trái của văn bản

D. Nhấn 2 lần chuột trái lên từ cần chọn

Câu 52: Nhấn tổ hợp phím Ctrl + N là chức năng gì?
A. Mở một tài liệu mới
B. Mở một tài liệu có sẵn trong đĩa

C. Lưu một tài liệu

D. Đóng chương trình Microsoft Word 

Câu 53: Vào File ( Chọn New ( Chọn Blank document ( Chọn Create là thao tác gì? 

A. Mở một tài liệu mới

B. Mở một tài liệu có sẵn trong đĩa.
C. Lưu một tài liệu.
D. Đóng chương trình Microsoft Word.
Câu 54: Thao tác vào File ( chọn Print hoặc Ctrl + P dùng để

A. Mở bảng chức năng in tài liệu.
B. Mở một tài liệu có sẵn trong đĩa.
C. Lưu một tài liệu.
D. Đóng chương trình Microsoft Word.
Câu 55: Sử dụng tổ hợp phím Ctrl + S, hoặc Click chuột vào biểu tượng [image: image12.png]


 trên thanh Ribbon là để

A. Mở một tài liệu mới.
B. Mở một tài liệu có sẵn trong đĩa.
C. Lưu một tài liệu.
D. Đóng chương trình Microsoft Word.
Câu 56: Để di chuyển con trỏ lên trên 1 trang màn hình ta bấm phím:
A. Backspace.
B. Home.
C. Page Down.
D. Page up.
Câu 57: Để di chuyển con trỏ về cuối dòng ta dùng phím: 

A. Home.
B. End.
C. Page Down.
D. Page up.
Câu 58: Trong chế độ tạo bảng (Table) của phần mềm MS Word 2010, muốn tách một ô thành nhiều ô, ta thực hiện:

A. Table ( Cells.
B. Table tools ( Layout ( Split Cells.
C. Table Tools ( Layout.
D. Table ( Split Cells.
Câu 59: Trong MS word 2010, phím tắt để bỏ thao tác vừa làm là:
A. Ctrl + Y
B. Ctrl + Z
C. Ctrl + L
D. Ctrl + T

Câu 60: Trong Word 2010, để ngắt trang văn bản, ta thực hiện

A. Chọn Insert, chọn Page Break.
B. Chọn Insert, chọn Break Page.
C. Chọn Home, chọn Page Break.
D. Chọn Home, chọn Break Page.
Câu 61: Trong Word, khi nào dùng lệnh Save As thay cho Save

A. Để chỉ định Word luôn luôn tạo bản sao dự phòng cho tài liệu.
B. Để gửi tài liệu cho ai đó qua thư điện tử.

C. Để thay đổi tần số thực hiện chức năng phục hồi tự động (AutoRecovery).
D. Để lưu một tài liệu dưới một tên khác hoặc tại vị trí khác.
II. Phần MS Excel
Câu 1: Trong bảng tính MS Excel 2010, tại ô A1 có giá trị chuỗi 2015, tại ô B1 gõ công thức =Len(A1) cho kết quả:

A. 2014
B. #DIV/0!
C. 4
D. 1

Câu 2: Trong MS Excel 2010, hàm SQRT(A9) dùng để:

A. Tính căn bậc hai của số A9
B. Tinh bình phương của A9

C. Tính giá trị tuyệt đối của số A9
D. Tính tổng của số A9

Câu 3: Trong MS Excel 2010, hàm MAX(8, 29, -11, 33, -51) cho kết quả

A. 8
B. -51
C. 33
D. 29

Câu 4: Trong MS Excel 2010, các dạng địa chỉ sau đây, địa chỉ nào là địa chỉ tuyệt đối?

A. $B$1:$D$10
B. B$1$:D$10$
C B$1:D$10
D. $B1:$D10

Câu 5: Trong MS Excel 2010, giả sử ô A1, A2, A3, có chứa lần lượt các số: 234, 235, 236, tại ô A4 ta điền công thức = COUNTA(A1:A3) thì kết quả là:

A. 2
B. 3
C. 4
D. 5

Câu 6: Trong MS Excel 2010, khi chiều dài dữ liệu kiểu số lớn hơn chiều rộng của ô thì sẽ hiện thị trong ô các kí tự:

A. $
B. &
C. *
D. #

Câu 7: Trong MS Excel 2010, để đổi chữ thường thành chữ IN HOA, ta chọn:

A. Hàm Upper
B. Hàm Proper
C. Hàm Lower
D. Hàm Len

Câu 8: Trong Excel, khi viết sai tên hàm trong tính toán, chương trình thông báo lỗi?

A. #DIV/0!
B. #NAME!
C. #N/A!
D. #VALUE!

Câu 9: Trong MS Excel 2010, công thức sau trả về giá trị nào: = IF(5 >= 5, "Không được tuyển dụng")

A. Không được tuyển dụng

B. Công thức sai vì trong Excel không có phép toán >=

C. 0

D. Công thức sai vì thiếu đối số trong hàm IF

Câu 10: Trong MS Excel 2010, công thức =LEN("Microsoft Excel 2010") cho kết quả

A. 20
B. 19
C. 21
D. 25

Câu 11: Trong bảng tính Excel 2010, tại ô A2 có sẵn giá trị chuỗi 2016 ; Tại ô B2 gõ vào công thức =VALUE(A2) thì nhận được kết quả :

A. #NAME!
B. Giá trị kiểu chuỗi 2016

C. #VALUE!
D. Giá trị kiểu số 2016

Câu 12: Trong bảng tính Excel 2010, nếu trong một ô tính có các kí hiệu #####, điều đó có nghĩa là gì?

A. Công thức nhập sai và Excel thông báo lỗi

B. Hàng chứa ô đó có độ cao quá thấp nên không hiển thị hết chữ số

C. Chương trình bảng tính bị nhiễm virus

D. Cột chứa ô đó có độ rộng quá hẹp nên không hiển thị hết chữ số

Câu 13: Trong MS Excel 2010, hàm SUM(-12, -5, 7, 100) cho kết quả:

A. 9
B. 100
C. 90
D. -90

Câu 14: Trong bảng tính Excel 2010, giao của một hàng và một cột được gọi là?

A. Trường
B. Công thức
C. ô
D. Dữ liệu

Câu 15: Trong MS Excel 2010, công thức =LEFT("Microsoft Windows ", 9) cho kết quả

A. t Windows
B. Microsoft

C. Windows
D. Microsoft Windows

Câu 16: Trong bảng tính MS Excel 2010, công thức =Upper(“TT TTTH”) cho kết quả:

A. TT TTTH
B. tt ttth
C. TT
D. TTTH

Câu 17: Trong bảng tính MS Excel 2010, để ẩn cột, ta thực hiện:
A. Thẻ View - Cells – Format - Hide&Unhide – Hide Columns

B. Thẻ Data - Cells – Format - Hide&Unhide – Hide Columns

C. Thẻ Home - Cells – Format - Hide&Unhide – Hide Columns

D. Thẻ Fomulas - Cells – Format - Hide&Unhide – Hide Columns

Câu 18: Trong bảng tính Excel 2010, điều kiện trong hàm IF được phát biểu dưới dạng một phép so sánh. Khi cần so sánh khác nhau thì sử dụng kí hiệu nào?

A. ><
B. #
C. <>
D. &

Câu 19: Trong bảng tính MS Excel 2010, tại ô A2 có giá trị số 10, tại ô B2 gõ công thức =PRODUCT(A2,5) cho kết quả:

A. #Value!
B. 10
C. 2
D. 50

Câu 20: Trong MS Excel 2010, để ghép 2 xâu ký tự "TRAN VAN" và "AN" thành xâu ký tự mới là "TRAN VAN AN", tư sử dụng công thức.

A. ="TRAN VAN" & "AN"
B. ="TRAN VAN" &" "& "AN"

C. ="TRAN VAN" AND "AN"
D. Không ghép được

Câu 21: Trong bảng tính Excel 2010, tại ô A2 có sẵn giá trị số không (0); tại ô B2 gõ vào công thức =5/A2 thì nhận được kết quả:

A. 0
B. 5
C. #VALUE!
D. #DIV/0!

Câu 22: Trong bảng tính MS Excel 2010, tại ô A2 có giá trị chuỗi 2016, tại ô B2 gõ vào công thức =VALUE(A2) cho kết quả:

A. #NAME!
B. Giá trị kiểu số 2016

C. #VALUE!
D. Giá trị kiểu chuỗi 2016

Câu 23: Trong bảng tính MS Excel 2010, tại ô A2 có giá trị chuỗi “a”, tại ô B2 gõ công thức =5/A2 cho kết quả:

A. #DIV/0!
B. 0
C. 5
D. #Value!

Câu 24: Trong bảng tính MS Excel 2010, để chèn hình ảnh, ta thực hiện:

A. Thẻ Fumulas – Picture
B. Thẻ Insert – Picture

C. Thẻ Data – Picture
D. Thẻ Review – Picture

Câu 25: Tài liệu của MS Excel 2010  được lưu trên đĩa với phần mở rộng:

A. DOC
B. XLSX
C. BMP
D. JPG

Câu 26: Khi đang làm việc với Excel 2010, tổ hợp phím nào cho phép ngay lập tức đưa con trỏ về ô đầu tiên (ô A1) của bảng tính ?

A. Alt+Home
B. Shift+Home
C. Ctrl+Home
D. Shift+Ctrl+Home

Câu 27: Trong MS Excel 2010, để có được chuỗi “ B” của chuỗi “ ABCD ” ở tại địa chỉ ô B5. Ta dùng công thức nào sau đây :

A. =MID(B5,2,1)
B. =LEFT(RIGHT(B5,2),1)

C. =MID(B5,1,2)
D. =RIGHT(LEFT(B5,1),1)

Câu 28: Trong bảng tính MS Excel 2010, tại ô A2 gõ vào công thức =MAX(3,14,-25,5) cho kết quả:

A. 3
B. -25
C. 5
D. 14

Câu 29: Trong MS Excel 2010, công thức sau sẽ trả về kết quả nào: = UPPER("tran thi Hoa")

A. tran thi hoa
B. Báo lỗi
C. Tran Thi Hoa
D. TRAN THI HOA

Câu 30: Trong Excel 2010, công thức sau sẽ cho kết quả như thế nào biết rằng các ô dữ liệu trong công thức đều lớn hơn 0 =IF(SUM(B2:D2)>=AVERAGE(B2:D2),1,0)

A. 13
B. 0
C. 14
D. 1

Câu 31: Trong MS Excel 2010, Trong bảng tính Excel đã cho ở Hình 1, tại ô M3 ta gõ vào công thức =IF(COUNTIF(E2:G2,">5")=3,"Đậu",IF(COUNTIF(E2:G2,">5")=2,"Thi Lại","Hỏng") thì nhận được kết quả:

A. Đậu
B. Thi Lại
C. Hỏng
D. #NAME!

Câu 32: Trong Excel, tại ô A2 có giá trị là chuỗi TINHOC. Tại ô B2 gõ công thức =RIGHT(A2,3) thì nhận được kết quả ?

A. 3
B. HOC
C. TIN
D. Tinhoc

Câu 33: Trong bảng tính MS Excel 2010, tại ô A2 có giá trị TINHOC, tại ô B2 gõ công thức =6/VALUE(A2) cho kết quả:

A. 6
B. TINHOC
C. #DIV/0!
D. #VALUE!

Câu 34: Công thức =TRIM(" Microsoft Excel 2010 ")

A. Micro soft
B. Microsoft Excel 2010

C. Microsoft Excel
D. Excel 2010

Câu 35: Trong bảng tính Excel, vùng là tập hợp nhiều ô kế cận tạo thành hình chữ nhật, địa chỉ vùng được thể hiện như câu nào sau đây là đúng?

A. B1-H15
B. B1..H15
C. B1...H15
D. B1:H15

Câu 36: Trong bảng tính MS Excel 2010, tại ô A1 có giá trị chuỗi “Excel”, ô B1 có giá trị số 2007, tại ô C1 gõ công thức =A1+B1 cho kết quả:

A. 2007
B. Excel2007
C. Excel
D. #VALUE!

Câu 37: Trong bảng tính Excel đã cho ở Hình 1, tại ô M3 ta gõ vào công thức =COUNTIF(C2:C7,"A")    thì nhận được kết quả:

A. 2
B. 1
C. 3
D. #NAME!

Câu 38: Trong bảng tính MS Excel 2010, điều kiện trong hàm IF được phát biểu dưới dạng một phép so sánh. Khi cần so sánh đồng thời nhiều điều kiện thì sử dụng hàm nào?

A. AND
B. &
C. OR
D. NOT

Câu 39: Công thức =RIGHT("Microsoft Excel 2010", 4) cho kết quả

A. 2010
B. Microsoft

C. Excel 2010
D. Microsoft Excel 2010

Câu 40: Trong bảng tính Excel 2010, tại ô A2 có sẵn dữ liệu là dãy kí tự "Tin hoc van phong" ; Tại ô B2 gõ vào công thức =LOWER(A2) thì nhận được kết quả?

A. TIN HOC VAN PHONG
B. Tin hoc van phong

C. tin hoc van phong
D. Tin Hoc Van Phong

Câu 41: Trong bảng tính MS Excel 2010, hàm nào sau đây cho phép đếm các giá trị thỏa mãn một điều kiện cho trước.

A. COUNT
B. SUM
C. COUTIF
D. SUMIF

Câu 42: Trong bảng tính Excel 2010, tại ô A2 có sẵn dữ liệu là dãy kí tự "Tin hoc van phong" ; Tại ô B2 gõ vào công thức =PROPER(A2) thì nhận được kết quả?

A. Tin hoc van phong
B. Tin hoc van phong

C. TIN HOC VAN PHONG
D. Tin Hoc Van Phong

Câu 43: Trong Excel 2010, tại ô A2 có giá trị là số 10 ; ô B2 có giá trị là số 3. Tại ô C2 gõ công thức =MOD(A2,B2) thì nhận được kết quả :

A. 1
B. 10
C. #Value
D. 3

Câu 44: Trong bảng tính MS Excel 2010, tại ô A1 có giá trị số 16, tại ô B1 gõ vào công thức =SQRT(A1) thì nhận được kết quả là:

A. #Value!
B. 4
C. 0
D. #Name!

Câu 45: Trong bảng tính Excel 2010, để sửa dữ liệu trong một ô tính mà không cần nhập lại, ta thực hiện:

A. Nháy chuột chọn ô tính cần sửa, rồi bấm phím F10

B. Nháy chuột chọn ô tính cần sửa, rồi bấm phím F4

C. Nháy chuột chọn ô tính cần sửa, rồi bấm phím F2

D. Nháy chuột chọn ô tính cần sửa, rồi bấm phím F12

Câu 46: Trong bảng tính MS Excel 2010, công thức = Lower(“ht CNTT”) cho kết quả:

A. ht cntt
B. Ht Cntt
C. HT CNTT
D. #NAME?

Câu 47: Trong Excel 2010, giả sử ô A1, A2, A3, có chứa lần lượt các số: 234, 235, 236, tại ô A4 ta điền công thức = ROUND(SUM(A1:A3),-1) thì kết quả là:

A. 649
B. 705
C. 710
D. 578

Câu 48: Trong MS Excel 2010, để xuống dòng trong cùng một ô, ta ấn tổ hợp phím :

A. Shift – Enter
B. Ctrl – Shift – Enter

C. Alt – Enter.
D. Ctrl – Enter

Câu 49: Trong Excel 2010, tại ô A2 có giá trị là số 2016. Tại ô B2 gõ công thức =LEN(A2) thì nhận được kết quả ?

A. #Value
B. 0
C. 4
D. 2016

Câu 50: Trong bảng tính Excel 2010, tại ô A2 gõ vào công thức =IF(3>5,100,IF(5<6,200,300)) thì kết quả nhận được tại ô A2 là:

A. 200
B. 5
C. 300
D. 100

Câu 51: Trong bảng tính Excel 2010, hàm nào sau đây cho phép tính tổng các giá trị kiểu số thỏa mãn một điều kiện cho trước?

A. SUM
B. COUNTIF
C. COUNT
D. SUMIF

Câu 52: Trong Excel 2010, hàm Average dùng để tính:

A. Trung bình các ô dữ liệu số không trống

B. Trung bình các ô dữ liệu số trống tính = 0

C. Trung bình các ô dữ liệu số kí tự tính = 0

D. Trung bình các ô dữ liệu số, có kí tự thì báo lỗi

Câu 53: Trong Excel 2010, giả sử ô A1, A2, A3, có chứa lần lượt các số: 234, 235, 236, tại ô A4 ta điền công thức = SUM(A1:A3) thì kết quả là:

A. 796
B. 705
C. 720
D. 710

Câu 54: Trong bảng tính MS Excel 2010, công thức =Mid(“m1234”,2,3) cho kết quả:

A. Chuỗi 123
B. Số 123
C. Số 234
D. Chuỗi 234

Câu 55: Trong các dạng địa chỉ sau đây, địa chỉ nào là địa chỉ tuyệt đối tại cột, tương đối tại hàng?

A. B$1:D$10
B. B$1$:D$10$
C. $B1:$D10
D. $B$1:$D$10

Câu 56: Trong bảng tính MS Excel 2010, công thức =Mod(26,7) cho kết quả:

A. 4
B. 5
C. 3
D. 6

Câu 57: Trong MS Excel 2010, giả sử tại ô B5 có công thức = A1+$B$2+C$3. Sau khi sao chép công thức đó từ ô B5 đến ô D8 sẽ có công thức

A. = C1 + $B$2 + E$3
B. = C4 + $B$2 + E$3

C. Báo lỗi
D. = A4 + $B$2 + C$3

Câu 58: Hàm =ROUND(123456.789,-3) sẽ cho kết quả là :

A. 123456.789
B. 123456
C. 123457
D. 123000

Câu 59: Trong bảng tính Excel 2010, tại ô A2 có sẵn giá trị số 25 ; tại ô B2 gõ vào công thức =SQRT(A2) thì nhận được kết quả:

A. #NAME!
B. 0
C. 5
D. #VALUE!

Câu 60: Trong bảng tính Excel đã cho ở Hình 1, tại ô M3 ta gõ vào công thức =IF(D2="CLS",1.5,IF(D2="CTB",1,IF(D2="MN",0.5,0)))    thì nhận được kết quả:

A. 0
B. 1.5
C. 0.5
D. 1

Câu 61: Trong Excel, AND, OR, NOT là:

A. Hàm của kiểu dữ liệu kiểu số.
B. Hàm của kiểu dữ liệu ngày

C. Hàm của kiểu dữ liệu kiểu Logic.
D. Hàm của kiểu chuỗi

Câu 62: Công thức = MAX(20,8,MIN(5,100)) cho kết quả là :

A. 100
B. 20
C. 5
D. 8

Câu 63: Trong bảng tính Excel đã cho ở Hình 1, tại ô M3 ta gõ vào công thức =SUM(E2:H2)  thì nhận được kết quả:

A. 13
B. 10
C. 11
D. 12

Câu 64: Hàm MIN(-52, 20, -11, 23, -15) cho kết quả:

A. 20
B. -52
C. -15
D. 23

Câu 65: Trong bảng tính MS Excel 2010, công thức =Right(“TTTTTH”,2) cho kết quả:

A. TTTT
B. TH
C. TTTH
D. TT

Câu 66: Trong bảng tính Excel đã cho ở Hình 1, tại ô M3 ta gõ vào công thức  =SUMIF(C2:C7,"A",E2:E7)   thì nhận được kết quả:

A. 12
B. 13
C. 10
D. #NAME!

Câu 67: Trong MS Excel hàm ABS(A7)  dùng để:

A. Tính tổng của số A7
B. Tinh bình phương của A7

C. Tính căn bậc hai của số A7
D. Tính giá trị tuyệt đối của số A7

Câu 68: Hàm MID(“Microsoft Excel 2010”,11,5)

A. “ Microsoft”
B. “Excel 2010”
C. “2010”
D. “Excel”

-----------------------------------------------
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Hình 1
----------- HẾT ----------

ĐỀ THI MINH HỌA
Câu 1: Trong Excel để sao chép dữ liệu từ vị trí này đến vị trí khác ta chọn:

A. Edit/ Copy, Edit/ Paste.
B. Ctrl + C, Ctrl + V.

C. Edit/ Copy, Edit/ Paste Special.
D. Cả 3 câu đều đúng.

Câu 2: Trong Excel để nối dữ liệu của 2 ô C1 và C2, ta chọn ô và dùng công thức:

A. = C1 & C2
B. = C1 $ C2
C. = C1 + C2
D. Cả 3 câu đều sai.

Câu 3: Trong Excel để rút trích dữ liệu ta chọn:

A. Tools/ Sort.
B. Data/ Filter.
C. Data/ Group.
D. Data/ Sort.

Câu 4: Trong Excel để tình giá trị trung bình của vùng dữ liệu số từ ô C1 đến C5, ta dùng công thức:

A. = Sum(C1:C5)/ 5
B. = Average(C1:C5)

C. = (C1 + C2 + C3 + C4 + C5)/ 5
D. Cả 3 câu đều đúng.

Câu 5: Trong Word nút lệnh [image: image14.png]


 dùng để:

A. Sao chép tập tin.
B. Lưu tập tin.
C. Mở tập tin.
D. Tạo tập tin.

Câu 6: Để sao chép một đoạn văn bản nào đó, quét chọn chúng, sau đó vào Menu
A. File > Copy > Đặt con trỏ vị trí mới, File > Paste
B. Edit > copy > Đặt con trỏ vị trí mới, Edit > Paste
C. Insert > Copy > Đặt con trỏ vị trí mới, Insert > Paste
D. View > Copy > Đặt con trỏ vị trí mới, View > Paste
Câu 7: Thứ tự các công cụ [image: image15.png]


  là:
A. Mở văn bản mới – Mở văn bản cũ – Lưu
B. Mở văn bản cũ – Mở văn bản mới – Lưu
C. Lưu – Mở văn bản cũ – Mở văn bản mới
D. Mở văn bản mới – Lưu – Mở văn bản cũ
Câu 8: Để thay thế từ hay cụm từ, ta thực hiện:

A. Lệnh Edit/ Go to.
B. Lệnh Edit/ Replace.
C. Lệnh Edit/ Search
D. Lệnh Edit/ Find.

Câu 9: Trong Excel để thêm một hàng vào bàng tính ta chọn:

A. Insert/ Columns.
B. Table/ Insert/ Columns.

C. Insert/ Row.
D. Edit/ Insert/ Row.

Câu 10: Trong Word nút lệnh [image: image16.png]


 dùng để:

A. Sao chép đoạn văn bản.
B. Dán đoạn văn bản.

C. Di chuyển đoạn văn bản đi nơi khác.
D. Lưu văn bản.

Câu 11: Công cụ
 [image: image17.png]


  dùng để:
A. Tô màu nền cho văn bản
B. Tô màu chữ cho văn bản
C. Tô màu gạch chân cho văn bản
D. Tô màu viền cho văn bản
Câu 12: Trong Excel ta dùng phím F2 là để:

A. Chính sửa dữ liệu một ô.
B. Tìm kiếm và thay thế.

C. Tìm kiếm nhưng không thay thế.
D. Cả 3 câu đều sai.

Câu 13: Trong Word nút lệnh [image: image18.png]


 dùng để:

A. Tạo nút Bullet đầu dòng.
B. Đánh số tự động.

C. Di chuyển đoạn văn bản sang phải.
D. Canh đều khoảng cách các dòng.

Câu 14: Trong Excel ta chọn Menu/ Insert/ Cells là để:

A. Thêm một hàng vào bảng tính.
B. Thêm một cột vào bảng tính đó.

C. Thêm một ô vào bảng tính đó.
D. Cả 3 câu đều sai.

Câu 15: Trong Word để lưu một văn bản với tên khác ta chọn:

A. File/ Save As.
B. Edit/ Save.
C. File/ Save.
D. Cả 3 câu đều đúng.

Câu 16: Trong Excel, một WorkBook có tối đa bao nhiêu Sheet (WorkSheet)?

A. Không xác định, tùy người sử dụng chọn.
B. 3.

C. 16.
D. 255.

Câu 17: Với bảng mã UNICODE, Font có thể gõ tiếng Việt được là:
A. VNI-Times
B. .VnTimes
C. Times New Roman
D. Tất cả đều được
Câu 18: Muốn lưu văn bản vào đĩa:

A. Chọn File/ Save.
B. Nhấn tổ hợp phím Ctrl + S.

C. Nhấn nút Save [image: image19.png]


 trên thanh công cụ.
D. Cả 3 câu trên đều đúng.

Câu 19: Trong Excel từ ô A1 đến A5 là dữ liệu số đều bằng 2, A6 và A7 đều là dữ liệu chuỗi, hàm Count(A1:A7) cho kết quả là:

A. 7
B. 20
C. 5
D. # Value.

Câu 20: Trong Excel ta dùng phím Ctrl + H là để:

A. Cài thuộc tính ẩn cho bảng tính.
B. Bảo mật bảng tính.

C. Tìm và thay thế dữ liệu.
D. Cả 3 câu đều sai.

Câu 21: Trong Excel để sắp xếp dữ liệu ta chọn:

A. Tools/ Sort.
B. Format/ Sort.
C. Table/ Sort.
D. Data/ Sort.

Câu 22: Trong Excel để xếp hạng ta dùng hàm:

A. Rand.
B. Round.
C. Sort.
D. Rank.

Câu 23: Trong Word nút lệnh [image: image20.png]


 dùng để:

A. Canh trái các dòng văn bản trong một đoạn.
B. Canh đều khoảng cách các dòng.

C. Canh phải các dòng văn bản trong một đoạn.
D. Canh đều các dòng văn bản trong một đoạn.

Câu 24: Để định dạng trang, ta thực hiện:

A. Edit/ Page Setup.
B. File/ Print Setup.
C. File/ Page Setup.
D. Format/ Page Setup.

Câu 25: Để dán văn bản đến một vị trí nào đó, ta chọn:

A. File/ Paste.
B. Ctrl + P.
C. Cả a và b đều đúng.
D. Cả a và b đều sai.

Câu 26: Trong Word để đánh ký hiệu thứ tự tự động đầu dòng, ta chọn:

A. Format/ Bullets and Numbering.
B. View/ Bullets and Numbering.

C. Insert/ Bullets and Numbering.
D. Cả 3 câu đều sai.

Câu 27: Trong Excel, để tìm và thay thế một dữ liệu ta vào:

A. View/ Replace.
B. Tools/ Replace.
C. Edit/ Replace.
D. File/ Replace.

Câu 28: Để đánh số thứ tự các đoạn văn bản, ta chọn:

A. Format/ Bullets and Numbering….
B. Edit/ Bullets and Numbering….

C. Insert/ Bullets and Numbering….
D. View/ Bullets and Numbering….

Câu 29: Để chọn nhiều cột không liên tiếp trong bảng tính Excel, ta thực hiện:

A. Nhấn và giữ phím Ctrl + Click chọn từng cột.
B. Nhấn và giữ phím Shift + Click chọn từng cột.

C. Nhấn và giữ phím Alt + Click chọn từng cột.
D. Không thể chọn được.

Câu 30: Để chọn nhiều cột liên tiếp trong bảng tính Excel, ta thực hiện:

A. Nhấn và giữ phím Alt + Click chọn cột đầu và cột cuối.

B. Nhấn và giữ phím Shift + Click chọn cột đầu và cột cuối.

C. Nhấn và giữ phím Ctrl + Click chọn cột đầu và cột cuối.

D. Không thể chọn được.

Câu 31: Muốn chèn ảnh có sẵn trong Word vào văn bản,ta:.

A. Chọn lệnh Insert/ Picture/ From File.
B. Nhấn Ctrl + P.

C. Chọn lệnh Insert/ Picture/ Clip Art.
D. Nhấn nút Insert.

Câu 32: Trong Excel, để tính trung bình của vùng dữ liệu số từ C1 đến C5 ta dùng công thức:

A. =Averag(C1:C5).
B. =Averge(C1:C5).
C. =Average(C1:C5).
D. =Averrage(C1:C5).

Câu 33: Tổ hợp phím Ctrl + Z là:

A. Khôi phục thao tác vừa thực hiện.
B. Hủy bỏ thao tác vừa xoá.

C. Khôi phục thao tác vừa hủy bỏ.
D. Hủy bỏ thao tác vừa thực hiện.

Câu 34: Trong Excel, Menu nào sau đây không có:

A. Insert.
B. Table.
C. Tools.
D. Format.

Câu 35: Trong Excel để tạo một tập tin mới ta chọn:

A. File/ New.
B. Tổ hợp phím Alt + F + N.

C. Cả a và b đều sai.
D. Cả a và b đều đúng.

Câu 36: Để tạo chữ cái lớn đầu đoạn văn trong Word, ta:

A. Chọn Format/ Drop Cap.
B. Chọn Format/ Characters/ Drop Cap.

C. Chọn Insert/ Drop Cap.
D. Chọn Tools/ Drop Cap.

Câu 37: Muốn xóa kí tự đứng trước con trỏ văn bản, ta dùng:
A. Phím Backspace
B. Phím Tab
C. Phím Delete
D. Phím Spasebar
Câu 38: Trong Excel ta chọn Insert/ Column là để:

A. Thêm một cột vào bên phải cột hiện hành.
B. Thêm một cột vào bên trái cột hiện hành.

C. Xoá cột hiện hành.
D. Cả 3 câu đều sai.

Câu 39: Trong Word để tạo bảng ta chọn:

A. Table/ Insert/ Table.
B. Insert/ column.
C. Tools/ Insert/ Table.
D. Insert/ Table.

Câu 40: Trong Excel ta chọn Menu/ Insert/ Worksheet là để:

A. Tạo một đồ thị.
B. Thêm một Sheet vào bảng tính đó.

C. Thêm một hàng vào bảng tính.
D. Cả 3 câu đều sai.

----HẾT----
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